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1. Overview 

Thank you very much for downloading RTS Tools. 

RTS Tools (RS Terminal Software Tools) is a Windows application that records balance 

data from SHINKO DENSHI electronic balances to a Windows PC. RTS Tools consists of two 

types of tools, RTSLogTool and RTSInputTool. 

 

RTSLogTool  

This is a tool for recording balance data in a Windows PC in text file format or CSV 

file format. 

The data imported to RTSLogTool is automatically saved in a file. 

You can send commands from the RTSLogTool to your balance. 

 

RTSInputTool 

This is a tool for recording balance data directly in your application (Microsoft 

Excel, etc.). 
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2. Note 

・ Before using RTS Tools, it is recommended to back up important data on Windows PC 

just in case.  

・ For Windows PC and commercial software other than RTS Tools, please contact each 

manufacturer. 

・ RTS Tools is not intended for legal for trade use. 

・ The copyright of this document belongs to SHINKO DENSHI CO., LTD., and part or all 

of the contents of this document cannot be reprinted or reproduced without 

permission. 

・ The contents of this manual are subject to change without notice. 

・ Microsoft, Windows, Excel and Word are registered trademarks or trademarks of 

Microsoft Corporation in the United States and other countries. 

・ The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth 

SIG, Inc. and any use of such marks by SHINKO DENSHI CO., LTD. is under license. 

Other trademarks and trade names are those of their respective owners. 
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3. License agreement 

・ Unauthorized copying of RTS Tools is prohibited.  

・ Specifications of RTS Tools are subject to change without notice. 

・ SHINKO DENSHI Co., Ltd. owns the copyright of RTS Tools. 

・ RTS Tools can be used to record data from SHINKO DENSHI electronic balances to a 

Windows PC.  

・ RTS Tools can be installed and used only on the hard disk or other storage device 

of the Windows PC connected to the balance. 

・ SHINKO DENSHI CO., LTD. shall not be held responsible for any direct or indirect, 

special or inevitable damage caused by defects in RTS Tools or this document, even 

if it is informed that such damage may occur. In addition, we are not responsible 

for claims of rights made by third parties. At the same time, we are not responsible 

for any loss of software or data. 

 

 

July 1, 2020 

SHINKO DENSHI CO., LTD. 
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4. Preparation before using 

4.1 Equipment 

Electronic balance 

Please have a SHINKO DENSHI’s electronic balance with RS-232C, USB, or Bluetooth. 

Windows PC 

The usage environment is as follows. 

item conditions 

Supported OS Windows 10 (64bit) 

.NET Framework Ver.4.6 or higher 

Display resolution XGA(1024×768 Pixel) or higher 

Note 

If the display size is set to anything other than 100%, the following phenomena may 

occur. 

・ The screen layout may be distorted. 

・ Characters on the screen are cut off in the middle. 

Application 

When using RTSInputTool, prepare a transfer destination application such as Microsoft 

Excel by yourself. 

Cable 

A cross cable is required for RS-232C connection between SHINKO EDNSHI’s electronic 

balance and Windows PC. 

For more details such as wiring diagrams, refer to the operation manual of the product 

you purchased. 
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4.2 Connection 

Connection between Electronic Balance and Windows PC (RS-232C, USB) 

Step 1. Select COM port 

Connect the prepared cable to the Windows PC and select the COM port on the Windows PC 

side. 

Step 2. Cable connections 

Connect the balance and the cable. 

Note 

When using USB connection, a USB driver is required. For more details, please refer to 

the operation manual of the product you purchased. 

Connecting the balance to a Windows PC (Bluetooth) 

Refer to the operation manual for the product you purchased, and pair the electronic 

balance and the PC. 

Balance settings 

For more details on the "Communication settings" and "Data output settings" of the 

balance, refer to the operation manual of the balance to be used. 
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5. RTSLogTool 

5.1 About RTSLogTool 

Feature 

・ You can control the balance by sending commands from a Windows PC. 

・ Data can be sent and received between the balance and Windows PC. 

・ The sent and received data can be displayed on the Windows PC screen and saved in 

text file format or CSV file format.  

・ Received data is automatically saved in a file. 

・ The sent and received data can be printed on the printer connected to the Windows 

PC. 

・ Communication can be performed simultaneously with multiple balances connected to 

the Windows PC. 

・ It can be executed simultaneously with other applications. 

・ The GLP output data of the balance can also be received. 
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5.2 Explanation of each part for RTSLogTool 

This tool consists of four blocks. 

1 Communication settings 

This block sets the communication settings of the tool. 

2 Receive settings 

This block sets the received data. 

3 Send command setting 

This block sets the send command. 

4 Send/receive log 

This block is used to start and stop logging. 
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5.3 Operating procedure 

5.3.1 Launching /Terminating the tool 

Step 1 Start RTSLogTool 

Launch from the “Start” menu of the Windows PC. 

Launch in the order of "Start"->"Programs"->"RTS Tools"->"RTS Log Tool". 

 

 

 

 

 

 

 

 

 

Step 2 Language setting 

Select Menu → Language → “English” to display in English. 

Step 3 Communication settings 

Set up each item of the communication settings to the communication settings of the 

balance. 

For more details on the settings, see "5.4 Description of Settings". 

Note 

・ When connecting multiple balances, do not specify the same port. 

Step 4 Terminate the tool 

Select Menu → File → Exit to terminating RTSLogTool.   
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5.3.2 Log starting/terminating 

Step 1 Start logging 

Click the [Start Log] button. 

Set the folder and file name to save the log, and click Save. 

The path and file name of the folder where the log is saved are displayed in [File 

save path]. 

The [Log Start] button turns gray on as shown in the figure and the communication 

becomes possible. 

 

 

 

 

 

 

 

 

 

 

 

Step 2 Data output from the balance 

Data is output from the balance. 

Step 3 Check the received data 

Confirm the weight value of the balance is displayed in [Latest Received Data] of the 

Windows PC. 

If the weight value is not displayed, refer to “8. Troubleshooting”. 

The received data is displayed in [Log data]. 

The received data is automatically saved in the file.  
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Step 4 Command transmission 

Select a command in [Send command] and click the [Send] button to send the command to 

the balance. 

Step 5 End log 

Click the [End Log] button to stop communication. 
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5.4 Explanation of settings 

1 Communication settings 

Match each communication setting to the communication setting of the balance body. 

 

Setting items. The content to display in the list 

Port COM port recognized by Windows PC. 

Baud rate 
1200・2400・4800・9600・19200・38400・57600・115200 

※Unit is bps. 

Parity None/Odd/Even 

Data length 
7・8 

※Unit is bit. 

Stop bit 
1・2 

※Unit is bit. 

Terminator CR/LF・CR 

2 Receive settings 

Set the received data. 

Format to use 

Set up the format output from the balance. 

・ Number 6-8 

Select when the output (communication) format of the balance is set to 6 digits 

numeric format, 7 digits numeric format, or 8 digits numeric format.  

・ CBM Printer 

Select when the output (communication) format of the balance is CBM format.  

・ Others 

Select when using GLP output data.  

Select this when using a format other than 6-8 and CBM printer.  

If selected, some features will be limited.   
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Data delimiter 

・ If checked, data delimiters are inserted during data logging.  

・ Select the delimiter from the comma space tab displayed in the list.  

・ If [Other] is selected as the format to use, data delimiter cannot be used.  

Output CSV header 

・ If checked, a CSV header will be output when logging starts.  

Format 

・ Select the log data format from ASCII or HEX.  

Output only numerical data 

・ When checked, only numerical data will be output. 

Additional information 

・ Set the data to be output in addition to the weighing data.  

・ If the number is checked, the number will be added to the beginning of the log 

data.  

・ If the date is checked, the date will be added after the log data.  

・ If the time is checked, the time will be added after the log data.  

Blank plus sign 

・ If checked, the + sign of the data is replaced by blank.  

・ If [Other] is selected as the format to be used, the plus sign cannot be blank.  

Beep sound when receiving 

・ If checked, the beep sound of the Windows PC will be emitted when receiving data.  
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・ The beeper may not sound depending on Windows PC.  
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３ Sending command setting 

Sending command 

・ Set the command to send.  

・ Commands can be selected from the list.  

・ Commands not in the list can be used by directly entering them in the [Send 

command] field.  

・ When a command is selected from the list, the command description is displayed 

below the [Send command] column.  

・ For the commands that can be used with the balance, refer to the instruction manual 

of the balance.  

Sending button 

・ Sends the command set in the [Send command] field.  

Automatic transmission 

・ If Auto Send is checked, the command will be sent automatically every set time.  

・ Time can be set in seconds.  

・ Set the value to 5 seconds or more.  

Note 

・ If Auto Send is not checked, click the [Send] button to send the command.  

・ When acquiring data for less than 1 second, set the data output control setting of 

the balance to "continuous output". 

・ For the data output interval in "continuous output", refer to the instruction 

manual of the balance to be used.  
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Automatic termination 

・ If automatic end is checked, command transmission will end automatically every set 

time.  

・ The time can be set in minutes.  

・ Set the value more than 1 minute.  

Display the send command in log 

・ If checked, the command sent will be displayed in the log.  
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４Sending/Receive log 

File save path 

・ The saving path and file name of the file to be logged are displayed.  

Browse button 

・ Open the save folder of the log file. 

Latest received data 

・ Display the latest data received. 

Log data 

・ Display the log of the received data. 

・ The log data size can be increased by increasing the size of the tool window. 

・ You can check the previous data by moving the scroll bar next to the log data. 

[Start Log] button 

・ Open the port and start communication. 

[End Log] button 

・ Communication will be stopped. 

[Log clear] button 

・ Clear [Log data] display 

[Log print] button 

・ Print the log data with the printer connected to the Windows PC. 
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6. RTSInputTool 

6.1 About RTSInputTool 

Feature 

・ Weighing data output from the balance can be directly transferred to applications 

such as Microsoft Excel. 

・ Weighing data output from the balance can be input to the application as if it were 

input from the keyboard. 

・ The application type does not matter. 

・ The GLP output data of the balance can also be received. 

Note 

・ When using Microsoft Excel, please use the display format setting the character 

string. 
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6.2 Explanation of each part 

This tool consists of 3 blocks.  

1 Communication settings 

This block sets the communication settings of the tool. 

2 Application 

This block sets the data input method and starts data input. 

3 Receive settings 

This block sets the received data. 
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6.3 Operating procedure 

6.3.1 Starting/terminating the tool 

Step 1 Start RTSInputTool 

Start it from the start menu of the Windows PC. 

Start it from the start menu of the Windows PC. 

Start in the order of "Start"->"Programs"->"RTS Tools"->"RTS Input Tool". 

 

 

 

 

 

 

 

 

 

Step 2 Language setting 

Select Menu → Language → English/English to display in Japanese. 

Step 3 RS-232C settings 

Match each item of the communication settings to the communication settings of the 

balance body. 

For details on the settings, refer to "6.4 Description of Settings". 

Step 4 Exit the tool 

Select Menu → File → Exit to quit RTSInputTool. 
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6.3.2 Start and end of use 

Step 1 External display 

Press the [Activate external display] button to display the external display. 

Step 2 Data output from the balance 

Data is output from the balance. 

Step 3 display confirmation 

Confirm that the weight value is displayed on the external display. 

If the weight value is not displayed, refer to “8. Troubleshooting”. 

The size of the external display can be changed. 

 

 

 

Step 4 Exit external display 

Click the [x] button to close the external display. 

Step 5 Start the external application 

Start an application (such as Microsoft Excel) that inputs data from the balance. 

Step 6 Windows PC input function settings 

Turn off the Japanese input function and set it to direct input. 
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Step 7 input position adjustment 

Please move the cursor to the place to input. 

If you are using Microsoft Excel, select the cell you want to enter. 

Step 8 start input 

Press the [Start input to application] button. 

The display is minimized and the data from the balance is ready to be received. 

Step 9 Input to external application 

Press the balance output key when the balance stability mark is illuminated. 

The data is transferred and entered at the cursor position. 

 

 

 

 

 

 

 

Step 10 end input 

Click RTS Input Tool on the task bar. 

Communication will be stopped and the normal display of RTS Input Tool will reappear. 
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Notes and memos 

・ RTSInputTool converts data to key code and sends the data to the application. If 

you move the cursor during communication, the data will be sent there, so be careful 

not to move the cursor. 

・ For inquiries regarding the destination application, please contact the 

manufacturer. 

・ The order in which the application and RTSInputTool are started does not matter. 

・ Data transfer is possible when RTSInputTool is minimized. 

・ To receive the RTSInputTool in the receivable state (minimized), place the cursor 

at the position to write the data on the input application. 

・ If the mouse or key input does not work, stop outputting data from the balance and 

wait until the screen data is no longer updated. Press RTSInputTool on the task 

bar, stop the communication, adjust the data reception interval setting, and thin 

out the data. 

・ When inputting data to Microsoft Excel and creating a graph in real time, the 

processing of Microsoft Excel may take time and may not operate properly. 
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6.4 Explanation of settings 

1 Communication settings 

Match each communication setting to the communication setting of the balance body. 

2 Application 

Data input method 

Set the operation after data input. 

・ Auto 

Insert Tab between the data and additional information, and Enter at the end of 

the data. 

・ ・Enter 

Insert Enter after data and additional information.  

・ Tab 

Insert Tab after data and additional information.  

  

Setting items. The content to display in the list 

Port COM port recognized by Windows PC. 

Baud rate 
1200・2400・4800・9600・19200・38400・57600・115200 

※Unit is bps. 

Parity None/Odd/Even 

Data length 
7・8 

※Unit is bit. 

Stop bit 
1・2 

※Unit is bit. 

Terminator CR/LF・CR 
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 [Start External Display] button 

・ Test display of data reception status from the balance. 

・ When you send data from the balance and the data is displayed on the external 

display, the reception status is normal. 

・ The size of the external display can be changed. The font size of the data is also 

changed according to the size. 

[Start input to Apprication] button 

・ Minimize RTSInputTool to be ready to receive data from the balance. 

・ When the data is received, the data is input at the cursor position of the 

application. 

・ To cancel the communication, click RTS Input Tool on the task bar. 

・ When communication is stopped, the normal RTS Input Tool display reappears. 

3 Receive settings.  

Format to use 

Set up the format output from the balance. 
 

・ Number 6-8 

Select when the output (communication) format of the balance is set to 6 digits 

numeric format, 7 digits numeric format, and 8 digits numeric format. 
 

・ CBM Printer 

Select when the output (communication) format of the balance is CBM format. 
 

・ Others 

Select when using GLP output data. 

Select this when using a format other than 6-8 and CBM printer. 

If selected, some features will be limited. 
 

Decimal point 

・ The decimal point of the data can be selected for dot (.) or comma (,). 

・ If [Other] is selected for the format to use, the decimal point cannot be 

selected. 
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Data delimiter 

・ If checked, data will be separated and logged. 

・ Select the delimiter from the comma space tab displayed in the list. 

・ If [Other] is selected as the format to use, data cannot be separated. 

 

Delete the auxiliary display digit delimiter (/[]) 

・ When checked, delete the auxiliary display digit separator (/,[,]) of received data. 

・ If [Other] is selected as the format to use, the delimiter cannot be deleted. 

Output only numerical data 

・ When checked, only numerical data will be output. 

Additional information 

・ Set the data to be output in addition to the weighing data. 

・ If the number is checked, the number will be added to the beginning of the log 

data. 

・ If the date is checked, the date will be added after the log data. 

・ If the time is checked, the time will be added after the log data. 

Blank plus sign 

・ If checked, leave the + sign of data blank. 

・ If [Other] is selected as the format to be used, the plus sign cannot be blank. 

Data reception interval 

・ If checked, you can set the data reception interval. 

・ When using the RTS, set the data output control setting of the balance to 

"continuous output". 
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Beep when receiving 

・ If checked, the beep sound of your Windows PC will be emitted when receiving data. 

・ The beeper may not sound depending on your Windows PC. 
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7. How to use (RTSLogTool・RTSInputTool) 

Describes how to use the tool and how to set the balance. Please refer to it. For the 

functions, operations, and setting methods of the balance, please refer to the 

instruction manual of the product you purchased. 

 

7.1  To enter the weight value in Excel 

・ Start Microsoft Excel. 

・ Run RTSInputTool.  Set the RTSInputTool as shown below. 

 

RTSInputTool items Settings 

Format 
6-8 digit or CBM 

(Match the balance settings) 

Stop position 
Add data delimiter 

Tab to data delimiter 

 

・ Press the [Data input] button to move the cursor to Microsoft Excel. 

・ Weighing value is output from the balance and input to Microsoft Excel. 

・ Calculate the total, maximum, minimum, average, standard deviation, etc. of the 

input data using the function function of Microsoft Excel. 

Balance settings 
After pressing Key, Output once 

when stable 

Tool to use RTSInputTool 

Application to use Microsoft Excel 
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7.2 Printing and recording the balance adjustment result 

・ Start RTSLogTool and start logging. 

・ The span adjustment result is output from the balance. The span adjustment result 

is automatically recorded in the file. 

・ Click the [Print Log] button of RTSLogTool to print to the printer connected to 

the Windows PC. 

Balance settings 
Enable output of span adjustment 

result 

Tool to use RTSLogTool 

Application to use Non 

 

7.3 Automatically import measurement results into Excel 

・ Set the output condition of the balance to automatic output (output once when 

stable). 

・ Start Microsoft Excel. 

・ Run RTSInputTool and press the [Start input to application] button to move the 

cursor to Microsoft Excel. 

・ Place the object to be measured on the balance. The balance outputs the weight 

value and inputs it into Microsoft Excel. 

Balance settings 
Automatic output (output once 

when stable) 

Tool to use RTSInputTool 

Application to use Microsoft Excel 
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7.4 View measurements on a large screen 

・ Run RTSInputTool and press the [Start External Display] button. 

・ Enlarge the external display according to the display of your Windows PC. 

・ The measured value is output from the balance. 

 

Balance settings Continuous output  

Tool to use RTSInputTool 

Application to use Non 
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7.5 Importing inventory results into Excel 

・ Set the balance to piece mode. 

・ Start Microsoft Excel. 

・ Run RTSInputTool and press the [Start input to application] button to move the 

cursor to Microsoft Excel. 

・ Place the parts to be inventoried on the balance and output the result (number). 

It is entered n Microsoft Excel. 

・ Use the function of Microsoft Excel to perform parts aggregation. 

Balance settings Counting mode  

Tool to use RTSInputTool 

Application to use Microsoft Excel 

 

7.6 Total animal weight 

・ Put the balance in animal mode. 

・ Start Microsoft Excel. 

・ Run RTSInputTool and press the [Start input to application] button to move the 

cursor to Microsoft Excel. 

・ Place the animal on the balance and output the weight of the animal. It is entered 

in Microsoft Excel. 

・ We will use the function of Microsoft Excel to perform totalization of weight. 

Balance settings Animal mode  

Tool to use RTSInputTool 

Application to use Microsoft Excel 
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8. Trouble Shooting 

8.1 Unable to record balance data on Windows PC 

If you cannot record the balance data on Windows PC using RTSLogTool・RTSInputTool, 

check the following items. 

Do not use other applications as much as possible. 

 

Check the connection 

Check point Counter-measure 

Is the cable you are using correct? (Using 

RS-232C/USB) 

Please refer to the instruction manual of 

the product you purchased and use the 

correct cable. 

Are you connected to the balance and Windows 

PC correctly? (Using RS-232C/USB) 

Please connect the cable between the balance 

and Widows PC. 

Did you install the USB driver correctly? 

(Uses USB) 

A USB driver is required when using USB. For 

details, please refer to the instruction 

manual of the product you purchased. 

Did the cable come off when using the tool? If the cable comes off while using the tool, 

you need to end the operation of the tool 

once. 

Did you pair? (Uses Bluetooth) When using Bluetooth, pairing is required. 

Refer to the instruction manual for the 

product you purchased to perform pairing. 
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Check communication settings 

Check point Counter-measure 

Are the balance and tool communication 

settings (excluding ports) set to the same? 

Set the balance and tool communication 

settings (excluding the port) to be the 

same. 

Have you selected the COM port connected to 

the balance as the port for communication 

settings? 

Select the COM port connected to the balance 

as the port for communication settings. 

If you change the COM settings, please end 

the operation of the tool once. 

Did you change the communication settings 

while using the tool 

If you change the communication settings 

while using the tool, terminate the 

operation of the tool once. 

 

 

Check output 

Check point Counter-measure 

Is data output from the balance? Please refer to the instruction manual of 

the product you purchased and output the 

data from the balance. 

Are you using a Shinko Denshi’s balance? Please use Shinko Denshi balances. The 

operation of this tool cannot be guaranteed 

if you use a third-party balance. 
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8.2 Error Messages 

If you receive an error message, please check the following actions: 

For RTSLogTool 

Error message Reason How to respond 

 Messages when logging is started 

by selecting an unusable port. 

Click the [End Log] button to 

end the log. 

Select an available port. 

Press the [Start Log] button to 

restart logging. 

 Messages when the communication 

conditions of the data from the 

balance and the communication 

conditions of the tool are 

different. 

lick the [End Log] button to end 

the log.  

Match the communication 

conditions with those of the 

balance.  

Press the [Start Log] button to 

restart logging. 

 Messages when the data from the 

balance and the tool format are 

different. 

Click the [End Log] button to 

end the log. 

Match the format used to the 

(output) format of the balance. 

Press the [Start Log] button to 

restart logging. 

  Messages when the [Send] button 

is clicked without starting 

logging. 

Press the [Start] button to 

start logging. 

Press the [Send] button to send 

the command. 

 Messages when the tool settings 

cannot be saved. 

Uninstall RTS Tools. 

Install RTS Tools again. 
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For RTSInputTool 

Error message Reason How to respond 

 Messages when logging is started 

by selecting an unusable port. 

Select an available port. 

Press the [Launch external 

display] or [Start input to app] 

button to start each operation. 

 Messages when the communication 

conditions of the data from the 

balance and the communication 

conditions of the tool are 

different. 

Match the communication 

conditions with those of the 

balance. 

Press the [Launch external 

display] or [Start input to app] 

button to start each operation. 

 Message displayed when multiple 

RTSInputTools are launched... 

 

 

 

Do not launch Multiple 

RTSInputTools. 

 Messages when the tool settings 

cannot be saved. 

 

 

 

Uninstall RTS Tools. 

Install RTS Tools again.  
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